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Today’s Panelists

Moderator: Phani Veeranki, MD, DrPH

Panelist: Patrice Verpillat, MD, MPH, PhD

Panelist: Daniel Prieto-Alhambra, MD, PhD

Panelist: Shuvayu Sen, PhD
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Phani Veeranki, MD, DrPH

Dr. Veeranki is a Senior Director & Principal Consultant at Optum Value &
Evidence Solutions Teams.

He is a physician-scientist and has significant expertise and experience in
clinical epidemiology, policy analysis and economic valuations to demonstrate
the value of healthcare interventions. He has served as an advisor and
investigator for numerous clinical trials, several cohort studies and cross-
sectional surveys along with hospital-based quality improvement projects.

He is a thought leader in conducting interventional and observational research
using real-world data and offers innovative clinical solutions, decentralized
clinical trial solutions, research approaches and strategies to clients and internal
partners. He has deep knowledge and expertise in methodological approaches
to address clients’ needs in multiple therapeutic areas including oncology,
cardiovascular, respiratory, neurology, and rare/genetic diseases.

His work has been published in leading journals including JAMA, CHEST, BMJ
and AJPH. Prior to joining Optum, he worked in various research capacities in
both academia and industry. He holds a MD and DrPH in epidemiology and
completed a fellowship in health outcomes research from Vanderbilt University
Medical Center.

He serves as moderator on the panel.
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Patrice Verpillat, MD, MPH, PhD

Dr. Verpillat is the Head of the Real-World Evidence (RWE)
Workstream at the European Medicines Agency (EMA).

He is a medical doctor by training and also an epidemiologist.
Before joining the EMA, he has worked ~20 years in the
pharmaceutical industry where he had held positions in several
international companies, always dealing with real world data (RWD)
and non-interventional studies (NIS) in order to bring RWE into
research, access and life-cycle product management.

He has published over 70 articles in Medline referenced journals.
He has been involved in many organizations such as ENCePP, ICH
M14 working group, European pharma association (efpia) and
ISPE.
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Dani Prieto Alhambra, MD, MSc, PhD

Professor Dani Prieto-Alhambra (MD, MSc (Oxon), PhD) is a
clinician scientist with a long track record in pharmaco- and device
epidemiology and real-world evidence research.

He led several initiatives and played a significant role in
accelerating and improving the quality of real-world evidence
internationally.

He leads the Health Data Sciences team at the Botnar Research
Centre (University of Oxford) and recently took the role of deputy
director for the EMA-funded DARWIN EU® initiative from the
Medical Informatics department, Erasmus MC, Rotterdam.

He leads the Development pillar for the generation and/or validation
of analytical tools to generate real world evidence for regulatory
use.
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Shuvayu Sen, PhD

Dr. Sen is Pharmaceutical executive with extensive leadership and
experience in real world evidence, pricing, market access,
reimbursement, big data, outcomes research, healthcare policy and
management and digital technologies at major pharmaceutical
companies.

His expertise lies in providing unigue insights in improving business &
scientific impact through the utilization of big data, real world evidence,
innovative trials, health programs, and health economics and outcomes
research. He made significant contributions to developing and delivering
novel evidence to obtain positive access/formulary decisions in the US,
EU, and Emerging Markets.

He has broad experience with both big and small molecules, and
vaccines in various therapeutic areas including Osteoporosis, Respiratory,
Endocrinology, Urology, Pain, infectious disease, Oncology,
Neuroscience, Immunology, Women'’s Health and Virology.

He is currently a Vice President and Head of Oncology, V&I Outcomes
Research at Merck.
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Antitrust Compliance Statement

ISPOR has a policy of strict compliance with both United States, and other
applicable international antitrust laws and regulations.

Antitrust laws prohibit competitors from engaging in actions that could result in
an unreasonable restraint of trade.

ISPOR members (and others attending ISPOR meetings and/or events) must
avoid discussing certain topics when they are together including, prices, fees,
rates, profit margins, or other terms or conditions of sale.

Members (and others attending ISPOR meetings and/or events) have an
obligation to terminate any discussion, seek legal counsel’s advice, or, if
necessary, terminate any meeting if the discussion might be construed to raise
antitrust risks.

The Antitrust policy is available on the ISPOR website.
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Disclosure

| have no conflicts of interest to declare

| am an employee of Optum LifeSciences. The views expressed in this
presentation are personal views only and may not be understood or
qguoted as being made on behalf of, or reflecting the position of Optum
or United Health Group
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Federated Data Health Networks

RWD/RWE are critical for healthcare decision-making (regulators, HTA bodies,
payers & prescribers).

RWD are healthcare data collected from observations of routine clinical practice
and not in conventional RCTs.

A single RWD or centralized approach has limitations- low sample size
(molecules for Rare diseases), longer f/u, low statistical power to built robust
prediction models

COVID-19 pandemic has further demonstrated need for a
distributed/decentralized federated data health networks (FDHN).

DARWIN-EU is a federated network enabling informed requlatory decision
making in EU.




RWE for Regulatory Decision-Making
DARWIN-EU
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Real-World-Evidence for Regulatory Decision-making

DARWIN EU®
Promises, Limitations and Challenges

European Regulatory perspectives
ISPOR Europe 2024

Presented by Patrice Verpillat on 18 November 2024
Data Analytics and Methods Taskforce, Real World Evidence Workstream Ay agencyof the European Union “
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Disclaimer

These slides are copyright of the European Medicines Agency.
Reproduction is permitted provided the source is acknowledged.

The presenter does not have any conflict of interest.

The views expressed in this presentation are personal views and may not be
understood or quoted as being made on behalf of, or reflecting the position of the
European Medicines Agency or one of its committees or working parties.
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EU Regulatory Perspective on “Clinical Evidence”

Patients

« Patient voice guides every step of the way [‘gﬁ/
- Evidence generation is planned and guided Transparency - nowledge /
by purpose, data, knowledge and expertise =
N\

« Research question drives evidence choice
and embraces spectrum of data and methods Clinical

« Clinical trials remain core but are evidence-based ) @Vidence Noection
smarter, better and faster - G2
g8,
=

* Real world evidence is enabled,
and its value is established

Evidence generation

Real-world N Clinical

evidence Trials

* High transparency level underpins societal trust

15
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3 main pathways to use RWD for generating RWE @EMA

] DARWIN
/\ i SEUAT

EMA studies using in-house Studies procured through
DARWIN EU®
databases EMA FWCs

+ Primary and secondary + Framework contract (FWC) + Coordination Centre launched
care health records from since September 2021: February 2022
France, Germany and UK services of 8 research . Onboarded 20 data

organisations and

L partners during the first 2
academic institutions years
» Access to wide network of . 20+ studies finalised
data sources: 59 data
sources from 21 EU + Additional 10 data partners
countries are foreseen to be added
» Ability to leverage external ;‘8;2 year for 2024 and

scientific expertise

16
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Data Analysis and Real-World Interrogation Network
DARWIN EU®

Committees Data Space

Data Source

Federated network of data,
expertise and services that
supports better decision-making
throughout the product lifecycle by
generating valid and reliable
evidence from real-world
healthcare data

-

)
- Coordination Data Permit U|l
U‘ - Centre Authority

Data Partner

FEDERATED NETWORK PRINCIPLES

—
. -
Direct Data =3
» Data stays local Partners
« Use of Common Data Model (OMOP) to —% SECEE
perform studies in a timely manner and e e AREISHEY

increase consistency of results

17




Data Partners
Access to data from ~ 130 million patients in 2024
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The Netherlands
Integrated Primary Care Information
Netherlands Cancer Registry

"\

Belgium
IQVIA Longitudinal Patient Database Belgium

United Kingdom

Clinical Practice Research Datalink (CPRD GOLD)
UK BioBank

France
Bordeaux University Hospital

Systéme National des Données de Santé 4

Portugal

Unidade Local de Salde de Matosinhos
Egas Moniz Health Alliance DataBase

Spain J

SIDIAP

Parc Salut Mar Barcelona, Hospital del Mar (IMIM)
BIFAP

Valencia Health System Integrated Database

Norway
Norwegian Linked Health Registries

Finland
( FinOMOP

Estonia
( University of Tartu (Biobank)

Denmark
Danish Health Data Registries
(onboarding in progress)

Germany
IQVIA Disease Analyzer Germany

\ Hungary
Semmelweis University Clinical Data

Croatia
Croatian National Public Health Information System

EUROPEAN
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How RWE can support regulatory decision-making?

Support the Investigate

Understand the

associations and
impact

planning and

clinical context validity

Design and feasibility
of studies

(Comparative)
Effectiveness and
safety studies

Disease epidemiology

Clinical management
Representativeness
and validity of
completed studies

Impact of regulatory

Drug utilisation actions

19
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Reports on RWE experience

HMA O EMA HMA O EMA
Published ' Published
Real-world evidence . Real-world evidence ]
framework to support in June framework to support in July
EU regulatory 2023 EU regulatory 2024

decision-making

2™ report on the experience gained
with regulator-led studies from
February 2023 to February 2024

decision-making

Report on the experience gained
with regulator-led studies from

September 2021 to February 2023 PerlOd Pe rIOd
covered: covered:
Sep 2021 Feb 2023
to Feb to Feb
2023 2024

20
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Focus on 2" report

60

NEW research topics
(Feb ‘23 - Feb ‘24)

Research

21

+18

Prior research
topics

topics

38 1 6 6 Studies |
DARWIN EU In-house | FwcC

DARWIN EBEWC

a7 » N
Feasible | Not feasible Feasibility
ongoing

22 20

Ongoing/ Not
on hold (2) accepted

Discontinued
Completed

o o [

In-house
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Study topics by ‘requester’ from Feb '23 to Feb 24

PRAC
PDCO
ecoc/eTr [T T
sawp I
CHMP
EMA (internal)

PRAC Pharmacovigilance Risk Assessment Committee

MSSG/SPOC PDCO Paediatric Committee
ECDC European Centre for Disease Prevention and Control
Hvec D ETF Emergency Task Force
SAWP Scientific Advice Working Party
COMP _ CHMP Committee for Medicinal Products for Human Use
1 1 MSSG Executive Steering Group on Shortages and Safety of Medicinal Products
HMPC Herbal Medicines Product Committee
HTA/Payers COMP  Committee for Orphan Medicinal Products
HTA Health Technology Assessment
EC European Commission
EC CAT Committee for Advanced Therapies
caT I
0 5 10 15

Numbers of researched topics

22 B Feasible = Not feasible ®Ongoing feasibility/On hold
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Type of research topic by use case and feasibility status

Crug utilisation

i ]
Ln

Safety 11 5
Disease epidemiology

Design and feasibility of future MAH/applicant...
Effectiveneass

Clinical management

DEJE
.
L L
(9]
[
[

Impact of regulatory actions

Represent. and validity of completed study

5 10 15 20

-

Number of unfeasible research topics

mFeasible  mMNot feasible  mOngoing feasibility
23
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®)

Research topics by Anatomical Therapeutic Chemical (ATC)

classification

L Antineoplastic and immunomodulating agents
J Antiinfectives for systemic use

A Alimentary tract and metabolism

10

Ln
L=y
oo
L

M Nervous system 3 1
C Cardiovascular system
V Various
R Respiratory system
M Musculo-skeletal system
G Genito-urinary system and sex hormones
B Blood and blood forming organs
D Dermatologicals
L:} 5 lll] 1I5
Number of requested research topics
m Feasible m Mot feasible m Ongoing feasibility

24
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Recommendations for enabling the use of RWE

Wider access to more diverse and
and other stakeholders.
complementary data sources.

Access to data sources [/_\ Collaboration . _ N
Close collaboration with decision-makers

/" Accelerate .~ Capacity and capability
Strategies to further accelerate RWE D D D Develop educational and knowledge
‘,/ generation. management sharing tools.

Regulatory context
Anticipate RWE needs of decision-makers
—

by identifying research questions earlier.

25
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In summary...
Past 4 pFuture 4

2018-2023 EMA Today 2025 ~2026
. -+ Scale-up ---» Optimised
- V4
As-is state, _ . usage of Our vision
ongoin RWE
L 4 T doed By 2025 enable
Past model priots use & establish
value of RWE
RWE maturity ) ) =
across the Agency mLe%l;\L/m MLe(())";‘t/J/m Medium High
e o Ry ™ ~10-15 ~40-50 ~80-100 ~100

Increase capacity (access to data

sources, breadths of studies/ analytical
26 pipelines), shorter timelines...
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Thank you!

Further information

Contact me at patrice.verpillat@ema.europa.eu

Official address Domenico Scarlattilaan 6 « 1083 HS Amsterdam « The Netherlands
Address for visits and deliveries Refer to www.ema.europa.eu/how-to-find-us
Send us a question Go to www.ema.europa.eu/contact Telephone +31 (0)88 781 6000

Follow us on ¥ @EMA_News



mailto:Sabine.Haubenreisser@ema.europa.eu

Introduction to DARWIN-EU
the Co-ordination Center
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DARWIN

SEUAT

Introduction to DARWIN EU:
the Co-Ordination Centre

Dani Prieto-Alhambra
Deputy Director, DARWIN EU
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AGENDA

 The Co-ordination Centre
 Development: Standardised analytics
« Study Operations

30 Presentation title (to edit, click Insert > Header & Footer)
e LIassinied as publiic Dy the European Medicines Agency
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AGENDA

e The Co-ordination Centre
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DARWIN EU® Coordination Centre

Executive Director

Prof. Peter Rijnbeek Erasmus MC
Head of the Department of Medical Informatics sy
Erasmus MC

Contractor

Sub-contractors

Deputy Director S UNIVERSITY OF
Prof. Daniel Prieto Alhambra ": © OXFORD
Erasmus MC, Oxford University

SYNAPSE @

=|QVIA

- < The Hyve

Deputy Director
Associate Prof. Katia Verhamme
Erasmus MC

ODYSSEUS

DATA SERVICES INC
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Establishment and Evolution of the Coordination Centre

Advisory Boards Executive Board

+ Scientific (SAB)

« Ethical (EAB)

+ Data Source Prioritisation
Committee (DSPC) Director

» General Assembly (GA)

Development Operations Technology
« QA/QC Procedures + Study execution « Infrastructure + Secretariat
* Vocabulary Extension » Network management + Security * Legal/ Contracting
+ CDM Development - Collaboration Environment * Finance
+ Methods Research + Analytics Platform + COI management
+ Analytical Tools » Source Control Repository » Risk management
+ Dashboarding - Website * Reporting
+ Training Material » Service Desk * Recruitment
* Protocol Templates « Training Platform » Qutreach
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What is needed to facilitate observational studies at scale?

A

111
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Generating Reliable Evidence using the OMOP Common Data Model

We need to make studies repeatable, reproducible, replicable, generalisable, and robust

Patient-level

data in source
system/schema

Patient-
level data «

in CDM

A Common Data Model enables
standardised analytics to generate
reliable evidence.
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AGENDA

 The Co-ordination Centre
- Development: Standardised analytics

36 Presentation title (to edit, click Insert > Header & Footer)
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Catalogue of Standard Data Analyses

Off-the-shelf studies

These are mainly characterisation questions that can be executed with a generic protocol. This
includes disease epidemiology, for example the estimation of the prevalence, incidence of
health outcomes in defined time periods and population groups, or drug utilization studies at the
population or patient level.

© Patient-level characterisation
© Patient-level DUS analyses
© Population-level DUS analyses

© Population-level descriptive epidemiology

Devel

© © © © © ©

Complex

These are studies requiring development or customisation of specific study designs, protocols,
analytics, phenotypes. This includes studies on the safety and effectiveness of medicines and
vaccines.

Prevalent user active comparator cohort studies

New user active comparator cohort

Self-controlled case risk interval

Self-controlled case series

Time series analyses and Difference-in-difference studies

RMM effectiveness

37



From Data Standardization
To Standardised Analytics

Disease

Drug Safety

Effectiveness

Standardize |
d analytics

11
L J

Italy

11 11
— —

UK Japan

11 11
— —

Sweden Estonia

Standardize

d data
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Building tools

Primary focus of the development pillar is providing tools (mostly
R packages) to help users to perform standard data analyses, and
training to facilitate the use of the resulting tools

V]

Devel 39
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Hacking a hard problem: Scaling up

Off the shelf Complex Very complex
Fully STD Pre-specified
(some bespoke)
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Draft Catalogue of Standard Analyses:

Off-the-shelf studies and examples

Standard Analysis Regulatory example

Population-level disease .
epidemiology .
Patient-level disease epidemiology -

Population-level DUS .

Patient-level DUS .

41

Prevalence of rare disease/s
Background rates of AESI or DMEs

Natural history/prognosis
Current practice/treatment patterns

Incidence and prevalence of use of
medicine/s over time

Describing indication/s for drug/s
Treatment duration, cumulative use
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Developing OMOP-Std

Analytical Pipelines
Off-the-shelf studies

These are mainly characterisation questions that can be executed with a generic protocol. This
includes disease epidemiology, for example the estimation of the prevalence, incidence of

CUDELIST health outcomes in defined time periods and population groups, or drug utilization studies at the
population or patient level.

61348178 MA*
4481927 =—
R73124

Patient-level characterisation
Patient-level DUS analyses

Population-level DUS analyses

INCIDENCE -
PREVALENCE :-

© © ©o ©

Population-level descriptive epidemiology

Cohort

CDMConnector Survival —
111 T
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AGENDA

 The Co-ordination Centre
 Development: Standardised analytics
« Study Operations
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What is the DARWIN EU® process for conducting studies?

Identify question

NCA/EI_VIA that may impact
Committee committee decision
NCA/EMA . Defing the research

. questions
Committee « Evaluate feasibility
Coordinating Centre Create protocol

Apply analytical pipelines

(NCA/EMA 1kh7 be Contact Data partners
consulted) Manage study governance
Data Partners Receive and run
(may include the code on their
NCA/ EMA) own databases

Integrate within EU
regulatory decision-
making process

Share aggregate data &
reports with requester
(support integration/
assessment)

* Receive, check, analyse
aggregated data

» Compile results in study
report

Send aggregated
data to the
Coordination

44
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. Study Exploration

Study Feasibility- Study request by EMA:

- Do we have the data? - Darwin Portal
- Do we have the analytical pipelines? (OTS)

. Study Initiation

- Work Order Form Data Partners
- Creation of Study Team: PI/data analyst
- Declaration of Interest

. Study Implementation

- Study outline/Protocol — Upload to EUPAS register
- IRB approval - Kick-off meeting

- Phenotyping — Cohort Diagnostics

- Study Package - Test Run

. Study Execution

- Data Partners run Study Package
- Data QC by Data Partners

- Results uploaded to DRE

- Results reviewed by PI

. Study Dissemination

- Generation of Study Report (ENCePP template)
- Upload to EUPAS register

- Manuscript generation

- Study archiving

g

[ EMA

[ Database Partners

]

Darwin CC:

- Network Pillar

- Development Pillar

- Technology Pillar
K_ Management Pillar

~

)




Some impactful DARWIN EU studies ...
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Example: Prevalence of Valproate use

Prevalence estimates

Group
Prevalence estimates are shown below.... ACI VARHA
0-4%1 4 CPRD GOLD
Database and study outcome

= IpCI
Database Outcome + + ‘} + IQVIA BELGIUM LPI
o IQVIA GERMANY D.
6 itemns selected ~ Valproate valpror ~ + + "o !
+ SIDIAP
0.3%{ +
Population settings } {
Age group Days prior history

Analysis settings

Prevalence
&
N
—
.

Prevalence start date

I

L] = = = m = . L] L}
0.0%
2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022
Year
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Example: Incidence of Valproate use

. P Group
300
Incidence estimates ACI VARHA
Incidence estimates are shown below.... + A  CPRD GOLD
+ m  [PCI

Database and study outcome + IQVIA BELGIUM LPI

Database Outcome 230
= [QVIA GERMANY D/

6 itemns selected ~ Valproate valpror = + SIDIAP

Population settings

[
=1
=3

Age group Days prior history

Analysis settings

o
=)

incidence start date

13 items selected ~

Incidence uf use (per 100,000 person-years)
I
8

—_—

" ]
. ] ] = u m 2 ] ] . ¥
0
2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022
Year

48



EUROPEAN
MEDICINES

AGENC

Large-Scale characterisation of Valproate users

Large scale characterization show 100 v |entries search:
In this tab you can see the large scale characterization of each of the analysed cohorts.
Qnly one cohort can be selected. Any . +366
" . 1to +1to +31to +91to
. time to -365to -365 to -90 to -1 -30to index days to
covariate +30 +90 +365 365
-366 -91 days -31 days day -1day date any
Database and population days days days days N
days time
Database Outcome
drug_era: 745466 1137/6412 6416/6416 | 6413/6413  6413/6413  5050/6315  4247/6132  2886/5346
(valproate) (17.7%) (100%) (100%) (100%) (80%) 169.3%) (54%)
drug_era: 1125315 2000/6412  1927/6416  2096/6416  1203/6416  922/6416 | 872/6416 | 1078/6413  1420/6413  2047/6315  1854/6132  2653/5346
Population settings (acetaminophen) (62.4%) (30%) (32.7%) (20.2%) (14.4%) (13.6%) (16.8%) (22.1%) (32.4%) (30.2%) (49.6%)
Sex Age group Indexyear group  Indication
drug_era: 923645 1773/6412  1010/6416  1103/6416  766/6416  608/6416 | 644/6416 | 752/6413  891/6413 1192/6315  1078/6132  1845/5346
(omeprazole) (27.7%) (15.7%) (17.2%) (11.9%) (9.5%) (10%) (11.7%) (13.9%) (18.9%) (17.6%) (34.5%)
drug_era: 723013 21516412 1061/6416  1214/6416 833/6416  632/6416 | 641/6416 | 730/6413  883/6413  1135/6315  1022/6132  1653/5346
Window parameters (diazepam) (33.5%) (16.5%) (18.9%) (13%) (9.9%) (10%) (11.4%) (13.8%) (18%) (16.7%) (30.9%)
Window Table Sort by
drug_era: 766814 764/6412  635/6416  695/6416 438/6416  553/6416  592/6413  6€52/6413  780/6315  716/6132  B78/5346
i L e (quetiapine) (11.9%) (9.9%) (10.8%) (6.8%) (8.6%) (9.2%) (10.2%) (12.4%) (11.7%) (16.4%)
drug_era: 1201620 3056/6412  1331/6416  1474/6416  B816/6416  571/6416  536/6416  651/6413  839/6413  1405/6315 12738132  2142/5346
(codeine) (47.7%) (20.7%) (23%) (12.7%) (8.9%) (8.4%) (10.2%) (13.9%) (22.2%) (20.8%) (40.1%)
drug_era: 1154343 1891/6412  988/6416  1060/6416  717/6416  526/6416 526/6416  647/6413  863/6413  1155/6315  1062/6132  1515/5346
(albuterol) (29.5%) (15.4%) (16.5%) (11.2%) (8.2%) (8.2%) (10.1%) (13.5%) (18.3%) (17.3%) (28.3%)
drug_era: 797617 1989/6412  T79/6416  831/6416  STUBAI6  461/6416  AT0/EA16  516/6413  576/6413  686/6315  629/6132  B32/5346
(citalopram) (31%) (12.1%) (13%) (9%) (7.2%) (7.3%) (8%) (9%) (10.9%) (10.3%) (15.6%)
drug_era: 1501700 264/6412 44416416 451/6416  430/6416  391/6416  447/6416  477/6413  SO7/6413  546/6315  523/6132  601/5346
(levothyroxine) (7.2%) (6.9%) (7%) ) (6.1%) (7%) (7.4%) (7.9%) (8.6%) (8.5%) (11.2%)
drug_era: 19044883 1595/6412  TEE/EA16  B6B/641E  SSU/BA16  401/6416  430/6416  519/6413 6326413 B70/6315  768/6132  1254/5346
(zopiclone) (24.9%) (11.9%) (13.5%) (6.2%) (6.7%) (8.1%) (9.9%) (13.8%) (12.5%) (23.5%)
drug_era: 710062 1602/6412  B18/6416  923/6416  585/6416  454/6416 382/6416  422/6413  S00/6413  661/6315  595/6132  1011/5346
(amitriptyline) (25%) (12.7%) (14.4%) ) (7.1%) (6%) (6.6%) (7.8%) (10.5%) (9.7%) (18.9%)
drug_era: 739138 1056/6412  S49/6416  G00/6416  A37/6A16  358/6416  37%/B416  406/6413  462/6413  5O6/E315  535/6132  1042/5346
(sertraline) (16.5%) (8.6%) (9.4%) (5.6%) (5.9%) (6.3%) (7.2%) (9.4%) (8.7%) (19.5%)

https://data-dev.darwin-eu.org/EUPAS50789/ 49
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The management of juvenile SLE
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The management of juvenile SLE (2)
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DARWIN EU : Opportunities for multi-stakeholder
collaboration
An Industry perspective
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RWE informs decision-making across the product life-cycle, for multiple stakeholders

Patients in observational studies (e.g., registries, hospital data) . RWE studies on drug/ patient outcomes |:| Patients treated, no active surveillance (e.g., data from EHR, biobanks, etc)

Initial License “Full” License

Number of patients treated
Number of studies run

Time (years)

Business

i i Regulator
development Trial design gu v

Payer / Reimbursement

Value-based care



DARWIN EU: an opportunity for stakeholders to become collaborators

Stakeholder Historical role

DARWIN EU Collaborator role

Patients Information Receivers Research (data) contributors
Providers Guideline/policy implementation Data-driven /value—based outcomes
Regulators Market approval authorizers ‘Real time’ risk-benefit evaluators
) Manage patients, prevent diseases,
Payers ViliEgs (pepulAiien: fund value-driven care
Medicine manufacturer and creator Patient-centric Innovators & quality
Pharma of information specific to their and value of care improver

innovation

A’"h"‘: Adapted from: http://pharmamarketresearchconference.com/usa/member-presentations-canada/member-presentations-canada-2014/th | f-real-world/th | f-real-world-evidence-improving-patient- omes_page_06/
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DARWIN-EU: Collaboration Opportunities

. Greater collaboration will further strengthen the RWE eco-system

« Rationale for Research topic and product selection

 Fit-for-purpose assessment methods and agreement on data quality requirements Completed

* Rationale for choice of study design and analytic methods for complex studies

Ongoing study
protocol/data analysis

* Interpretation / contextualization of findings and impact on downstream (e.g. HTA) decision-making
Feasible

« Efficient sharing / re-use of data quality assessment tools, methods and infrastructure across stakeholders.

Total number of Nat Feasible

Net accepted
research topics

Ongoing feasibility

Figure 3. New research topics identified between 8 February 2023 to 7 February 2024,

EMA DARWIN-EU, 2" report, 2024
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DARWIN-EU: Collaboration opportunities

. How can we make the execution process more inclusive & findings more representative ?

* Very short MAH! review timelines for new protocols.

Drug utilisation

o]
(%]

* Opportunity to include other stakeholders to clarify HTA relevance for specific findings.
Safety 1

* Opportunity to co-develop well-defined strategy to establish representativeness of selected data sources Disease epidemiology

Design and feasibility of future MAH/applicant...

* Opportunity to include research topics that focus on evaluating the representativeness and validity of i
completed studies. Effectiveness

[ [
A
w [¥)]
wu
)
Ll .
1))

Clinical management

Impact of regulatory actions
|

Represent. and validity of completed study I
L R NN NNl T T ——————1
0 5 10 15 20

Number of unfeasible research topics

B Feasible H Not feasible B Ongoing feasihility

Figure 7. Type of research topic (new research questions identified during the reporting period) by use case and
feasibility status (n=60).

1 - Manufacturing Authorization holder HMA-EMA Joint Big Data Task Force Phase Il report : ‘Evolving Data-driven Regulation”
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ISPOR, the professional society for health economics and
outcomes research (HEOR), is an international, multistakeholder,
nonprofit dedicated to advancing HEOR excellence to improve
decision making for health globally. The Society is the leading
source for scientific conferences,

peer-reviewed and MEDLINE-indexed publications, good
practices guidance, education, collaboration, and tools/resources

in the field.

ISPOR’s community of more than 20,000 individual and chapter
members from 120+ countries includes a wide variety of
healthcare stakeholders, including researchers, academicians,
regulators and assessors, public and private payers, healthcare
providers, industry, and patient representatives. The Society’s
leadership has served as an unbiased resource and catalyst for

innovation in the field for more than 20 years.

www.ispor.org

= |ISPOR

Improving healthcare decisions
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